**Class Description:**

Never used a computer before? Feel like computer terms are written in a different language? Come learn about computer basics. Class will provide an introduction to using the mouse and keyboard. Other topics covered include instruction on working with windows and a discussion of computer terminology.

**Class Length:** 2 hours

**Introduction:**

You can’t look around these days without noticing computers. They line the walls of schools, libraries, hospitals, offices, stores, and governmental agencies. We see them on television. People even carry them around! Computers have become a daily presence in our lives even for those of us who have not used one before. This class is targeted at beginning computer users. Class will provide basic instruction from turning the computer on, to using the mouse, to performing basic computer tasks.

**Objectives:**

- Learn about computer hardware/software and develop working knowledge of computer terminology.
- Use the mouse and become familiar with the keyboard.
- Perform basic computer tasks in a Windows environment.
- Troubleshoot computer problems and perform proper shutdown procedures.

**Exercises:**

1) Getting Started
   - Computer Terminology
   - Computer Comparison Chart
   - Using the Mouse

2) Working with Windows
   - The Desktop, Taskbar, and Start Menu
   - Parts of a Window
   - The Calculator
   - Scrolling

3) Keyboarding
   - The Keyboard
   - Access the Ainsworth Keyboard Trainer
   - Take Lessons
   - View Progress Report and Exit Program

4) Troubleshooting Tips and Proper Shutdown Procedures
   - Handling a Frozen Computer
   - Restarting the Computer (Reboot)
   - Turning the Computer Off
Using the Mouse

What is a Mouse?
The mouse is a hand-controlled pointing device that allows you to activate commands on the computer screen. It serves as a connection between you and the computer.

Proper Hand Position and Placement
The index finger should remain on the left button and the middle finger should rest on the right button. The mouse should remain on a flat surface, preferably a mouse pad at all times.

Moving the Cursor
There are two roller pins inside the mouse. One allows for movement left and right, the other allows for movement up and down. The roller ball inside the mouse enables the mouse, or cursor that is displayed on the screen, to move in two directions at once.

As you begin to move the mouse, you will notice an arrow on your screen. This arrow is referred to as the cursor. The shape of the cursor changes depending upon the particular action that is being performed, or what application is currently being used. In today’s class, the cursor will appear as an arrow, which allows you to click on menus and toolbar buttons and as the I-beam, which displays when text or numbers are being typed.

Practice Exercise

Steps:
1. Locate the cursor on screen.
2. Move the mouse left and right.
3. Notice the speed at which the cursor moves on the screen.
4. Now try moving the cursor up and down.
5. Again notice the speed at which the mouse moves on the screen.
6. Try moving the mouse diagonally.

Quick Fact: The mouse was invented in 1963 by Douglas Engelbart of the Stanford Research Institute who commented, “it was nicknamed the mouse because the tail came out.”

Single Clicking
Once you feel comfortable moving the mouse, you will need to single click to activate a command or select an object. In other words, you need to tell the computer what you would like to do. Do you want to open a program? Print a web site? In order to perform such actions you will need to click. Most clicking is performed with the left mouse button.
Using the Mouse

Practice Exercise

Steps:
1. Locate the **Start button** in the left-hand corner of the screen.
2. Place the cursor on top of the **Start button** and click once with the left mouse button.
   - A menu opens and displays all of the available computer programs.
3. Click outside this menu to close it (anywhere on the desktop).
4. Click on the **Start button** again to open the menu.
5. Now try moving the mouse upward.
6. Notice that as the mouse moves, it selects the current item with a dark blue or purplish color. A simple **click** will open the desired **application**
7. Click outside the menu to close it.

Double Clicking
Double clicking involves clicking the left mouse button twice in rapid succession. Double clicking usually is performed on icons which appear on the desktop. Such icons do not appear on library computers, and that is why you will rarely double click while working on library computers.

Right Clicking
Right clicking involves clicking the right mouse button. The right click is used to open a shortcut menu to access a specific command.

Click and Drag
In order to move icons on the desktop, a file to a folder, or a card in a game of solitaire, you will need to click and drag. This involves, clicking on an object, holding the click, and dragging the mouse across the mouse pad. Think of it like mouse gymnastics. Once you get a handle of this, you are a true mouse master!

Tips for Cleaning the Mouse:
It is important to keep the inside of the mouse clean and free of dust and dirt. When the inside of a mouse becomes dirty, it can be difficult to use. To remove dirt and grime that can accumulate on the rollers, you can use your fingernail or tweezers. Some recommend using a cotton swab dampened with rubbing alcohol. To remove dust from the ball, try using a piece of scotch tape or cloth.

Remember, to help keep your mouse clean, always use a mouse pad and keep your workspace free of beverages, dust, dirt, and hair. To avoid cleaning your mouse altogether, you may want to purchase an optical mouse…
Desktop, Taskbar, and Start Menu

**Desktop:** Once the computer has been turned on and the operating system has been loaded, the first screen that displays is the *desktop*. You might want to imagine the computer as being one large desk that contains a number of files, folders, and tools that you can use to perform different tasks. The *desktop* may look different depending upon the computer. At the Milwaukee Public Library, the desktop has a picture of the Central Library. On other computers, it may be a solid color, design, or image. On non-library computers there usually are a number of icons that display on the *desktop*.

**Taskbar:** The *taskbar* is located at the bottom of your screen. On the right hand side of the *taskbar* is a clock that displays the current time. If you move the mouse on top of the clock and pause, the day and date will display momentarily. On the left-hand side of the *taskbar* is the **Start button** that displays available applications on the computer. The *taskbar* will show how many *Windows* are currently open. You can use the *taskbar* to move from one window to another.

**Start Menu:** You can use the **Start button** to open programs that are available on the computer, just as you would open a drawer to access your files or other office tools such as a calculator.
Parts of a Window

- Title Bar
- Menu Bar
- Toolbar
- Close/Exit
- Restore/Maximize
- Minimize
- Status Bar
- Scroll Bar
The Calculator

The calculator is a small program that allows you to perform operations. There are two views, standard for basic operations, and scientific for more difficult calculations.

1. Click on the Start button.
   - The Start menu opens.
2. Click on Calculator to select it (purple shading should appear) and click once to open the program.
3. To move the window, click on the title bar, click and hold the mouse, drag the window to the middle of the desktop, and release the click.
   - The window will now display in the middle of the desktop.
4. Click on the View menu and select Scientific. The calculator expands and allows for more complex calculations.
5. Click on the View menu and Select Standard, the calculator goes back to the original view.
6. You can use the mouse or the keyboard to perform calculations. Try it!

- Division
- Multiplication
- Subtraction
- Addition

- In order to clear an entire operation, click the C button on the calculator.
- To clear the last number entered, click the CE button. CE stands for Clear Entry.
- The Delete key (to the left of the numeric keypad) will also clear the last entry.
- The Backspace button or Backspace key can be used to delete one space to the left.
- The Esc key can be used to clear the entire operation.
- The Enter key on the numeric keypad is equivalent to the Equal sign (=) on the Calculator.

The Num Lock key turns the numeric keypad on the keyboard on and off. The green light will display if the numeric keypad is turned on.
Scrolling

What is scrolling?

Scrolling is the act of sliding a horizontal or vertical presentation of content, such as text, drawings, or images, across a screen or display window.

Why do I need to scroll?

Scrolling allows you to see all the data that does not fit onto your screen. You can scroll up and down (vertically) and also side to side (horizontally).

There are several ways to scroll.

- Click and drag the scroll box up and down inside the “elevator”.

- Or, click inside the elevator that does not hold the scroll box.

- Or, the arrow buttons may be gently clicked to scroll a small amount.

- You can also use the scroll wheel on your mouse (if available).

1. Go to the Library’s Home Page.
2. Scroll down using any of the above methods until you see Computer Classes listed on the right-hand side of the screen.
3. Click on Computer Classes.
4. Scroll down to find the classes at your neighborhood library.
The Keyboard

Control and Alt Keys
Used in combination with other keys as shortcuts that can be used to activate commands (e.g. Ctrl and P keys will activate the print command).

Arrow Keys
Allows you to move the cursor up and down, and left and right (often used in word processing or spreadsheet programs).

Backspace Key
Deletes one character to the left of the cursor.

Delete Key
Deletes one character to the right of the cursor.

Caps Lock Key
Press this key to type all characters in uppercase. Press it again to turn it off.

Enter Key
Sometimes referred to as the “return” key. It is used to activate a command, or move to the next line while working in a word processing program.

Esc Key
Short for “Escape,” this key is used to exit (or escape) from tasks (for example, closing a menu or dialog box).

Function Keys
Special keys labeled F1 to F12. Often these keys are used to perform shortcuts in programs. Each program uses these keys for different commands. Usually the F1 key is used to activate Help.

Shift Key
Allows you to capitalize a letter or type the symbols or other characters which appear on the top portion of the keys.

Space Bar
Inserts one space between characters.
Accessing the Ainsworth Keyboard Trainer

The Ainsworth Keyboard Trainer is an excellent program to learn whether you are a beginning user who needs to learn keyboarding or for more experienced typists who are looking to improve speed and accuracy.

1. Insert a floppy disk into the A drive.
2. Click the Start button on the Taskbar at the bottom left-hand corner of the screen.
3. Click on Programs.
   • A submenu displays.
4. Click on Internet Explorer.
5. Click on Research Resources.
6. Click on Library Databases.
7. Click on the full listing of Library Databases A-Z link.
8. Scroll down until you can click on Ainsworth Keyboard Trainer
   • The Ainsworth Keyboard Trainer Program launches.
   • The “Name…” dialog box displays.
9. Type in your first name or initials.
10. Click the OK button or press the Enter key.
    • The Ainsworth Keyboard Trainer Window displays.
The Ainsworth Keyboard Trainer Window

- Title Bar
- Menu Bar
- Minimize
- Maximize/Restore
- Close/Exit
- Name that you entered

Using the KEYBOARD program...

- Lessons
- Drills
- Tests
- TypeOn
- Reports
- View
- Help

Learn to type. Master the Alphabet Keys first. Then add Punctuation to gain word processing skills.

Improve your speed and accuracy. Drills give you focused practice to automatically detect and eliminate weak keys.

Measure and record your progress with a Word Processing Test or a Basic Skills Test.

Have fun with TypeOn! Combine logic with keyboarding skills to improve your ability to think and type at the same time.

View Reports or print a one-page summary to document your progress.

Use the Ainsworth Conversation Piece or the Ainsworth Writer to improve your communication skills.

Press the F1 key at any time for help. Try it now and see.

Copyright © 1999-2008 Ainsworth & Partners, Inc. All rights reserved.
Take Lessons

Lessons provide an introduction to the keyboard beginning with keys located on the home row. The Ainsworth Keyboard Trainer Program will automatically adjust based on your skill level.

1. The **Ainsworth Keyboard Trainer** program should be open.
2. Click the **Lessons** button.
   - The **Lesson** menu opens.
3. Click on **Alphabet Keys**.
   - The “**Starting your lessons...**” dialog box opens. The first lesson focuses on the **A S D F** keys. Your speed and accuracy will be monitored.
4. Press the **Enter key** or click the **OK button** to begin.
5. In the white box near the top of your screen, begin typing the letters as well as spaces as they appear.
6. Continue taking the lessons.

**Press the Backspace key** to correct mistakes.

**Note:** Experienced typists may prefer taking the **Drills** and **Tests** for more challenging exercises.
A progress report is generated when you use the Ainsworth Keyboard Trainer (Use with Disk) option. The report provides an analysis of the lessons you have taken listing your best speed, best accuracy, and the number of lessons completed.

1. Click the **Using the Program menu** to get back to the beginning screen.
2. Click on the **Reports button**.
   - The **Reports menu** opens.
3. Click on **Progress Report**.
   - A Progress Report displays. Notice the various buttons for viewing progress on all parts of the program.
4. Click the **Alphabet Keys button** to display the characters on the chart.
5. To exit program, click the **File menu** and select **Exit**.
   - A dialog box will appear briefly indicating your work is being saved to the disk.
   - The program will close and your work will automatically be saved on the disk.
Troubleshooting Tips

**Warm Boot:** Performed on PCs by pressing the Ctrl and Alt and Delete keys at the same time. Warm boots can be performed when the system crashes, the computer locks up, or freezes.

*Steps*
1. Press the Ctrl and Alt and Delete keys.
   - A box should appear allowing you to end the task. Usually this helps when a program is not responding or a glitch has occurred. On library computers however, this may work differently because of the network’s configuration. **Never perform a warm boot on library computers. If you should experience a problem with a library computer, ask a Librarian for assistance.**

**Reboot:** Involves restarting the machine. This sometimes can help clear any problems (e.g. such as a slow computer). **If you should experience a problem with a library computer, ask a Librarian for assistance.**

*Steps*
1. Click the Start button on the Taskbar.
2. Click Shutdown.
3. Using the drop-down menu, select “Restart”
4. Click the OK button.

**Cold Boot:** Turning the computer on and off. This should only be done when you cannot perform a warm boot or a reboot. **Never perform a cold boot on library computers. If you should experience a problem with a library computer, ask a Librarian for assistance.**

*Steps*
1. Turn the power off by pressing the power switches on the CPU or turning off the surge protector.
2. Wait a moment (at least 30 seconds).
3. Turn the power buttons back on or turn the surge protector back on.

Make sure to plug your computer into a surge protector rather than directly into a wall outlet.
Proper Shutdown Procedures

It is important that when you are finished working on the computer that you follow proper shutdown procedures. If you simply turn the power off, there is not enough time for the computer to shutdown and put files in the proper place. If you do this once or twice, it may not harm the machine, but repeatedly doing so will cause the files to become corrupted resulting in computer malfunction.

1. Click on the **Start button**.
   - The **Start menu** opens.
2. Click on **Shutdown**.
   - The **Shutdown dialog box** appears.
3. If not selected, select from the drop-down menu “Shut down”.
4. Click **OK**.
   - The computer writes unsaved data to disk and shuts down.

*Note:* you do not have to shutdown computers at the library.
Glossary of Computer Terms

**Bit**: Short for binary digit. The smallest unit of information represented by either a zero or one.

8 bits = 1 byte

- **Enough memory to store one character** (for example, the letter A)
- **1,024** (approximately one thousand) bytes = 1 kilobyte, abbreviated KB
- **Enough memory to store a 200-word essay (almost one page)**
- **1,048,576** (approximately one million) bytes = 1 megabyte, abbreviated MB,
- **Enough memory to store 200,000 words (almost 1,000 pages)**
- **1,073,741,824** (approximately one billion) bytes = 1 gigabyte, abbreviated GB
- **Enough memory to store 200,000,000 words (almost 1,000,000 pages)**

**CD-ROM**: Acronym for Compact Disk - Read Only Memory. A CD-ROM can store up to 650 MB of information. Most of the software is available on CD-ROM for installation on your PC. A CD-ROM drive can read CD-ROMs as well as music CDs.

**CD-R**: Acronym for Compact Disk – Recordable. A CD-R drive can be used to not just install software or play music CDs, but also record information. However, it is only possible to record information to the disk once.

**CD-RW**: Acronym for Compact Disk – Recordable Writeable. A CD-RW drive allows users to record and erase information onto a disk multiple times. You can use the CD-RW drive to back-up files on your computer or to create music CDs.

**CPU**: Acronym for Central Processing Unit. You can think of the CPU as the brain of the computer; it is responsible for everything the PC does. There are different brands of processors such as Pentium or Celeron. The speed at which a CPU processes information is measured in Megahertz (MHz) or Gigahertz (GHz).

**Database program**: One used to create and manage large amounts of information in one place. For example, the state of Wisconsin keeps your driver’s license number and other information in a database. An example of a database program is Microsoft Access.

**DVD**: Acronym for Digital Video Disk or Digital Versatile Disk. DVDs can store large amounts of information whether it is large computer files or full length movies. A standard single-layer, single-sided can store 4.75 GB. However, two layer DVDs can store 8.5 GB and double sided DVDs can store 17 GB.

**Floppy disk**: A disk that stores information magnetically. Most disks are formatted and can store 1.44 MB of data. It is important to keep disks away from extreme heat and cold, liquids, and magnets. It is recommended that you keep disks in a protective case.
**Glossary of Computer Terms**

**GHz:** Abbreviation for Gigahertz. One GHz represents one billion cycles per second. The speed of the CPU is measured in Gigahertz. The higher the number, the faster it goes.

**GUI:** Pronounced “Gooey”, this acronym stands for *graphical user interface* which allows you to activate commands or perform certain tasks by clicking on menus or icons, rather than typing in cryptic commands. For example, you can click on the picture of a *printer* to print a document.

**Hard drive:** The primary storage area within your computer, usually a hard, metal disk. The higher the number attached, the more storage room you have for programs as well as files created with those programs.

**Hardware:** Anything you can physically touch, such as the mouse, keyboard, monitor, CPU, or printer.

**MHz:** Abbreviation for Megahertz. One MHz represents one million cycles per second. The speed of the CPU is measured in Megahertz. The higher the number, the faster it goes.

**Modem:** Device used to access the Internet via the telephone. The fastest modem on the market today is 56k v90. Modems are measured by how much information can be transferred per second, or kilobits per second (Kbps).

**Operating System:** The operating system, or OS, is a piece of software that runs the computer. The operating system is responsible for starting the computer and executing commands like printing documents, opening programs, and so forth. Windows is the operating system most likely installed on your computer and is the operating system used here at the library. The operating system is a program that runs the computer. Whenever you turn on the computer, one of the first things a computer does is search for its operating system. The operating system manages the central processing unit and ensures that the commands you give the computer—like opening a program, saving a file, or printing a document—will be performed.

**PC:** Stands for Personal Computer.

**Presentation program:** One used to create slide show presentations. An example of a presentation program is Microsoft PowerPoint.

**Program “suite”:** A series of programs that function as a package. The Microsoft Office suite contains Word, Excel, PowerPoint, and Access.
Glossary of Computer Terms

**RAM**: Abbreviation for Random Access Memory. Often times people refer to RAM as Memory. RAM, or memory, can be thought of as a workspace. The more RAM you have, the more workspace you have. The more workspace you have, the more projects you can do at one time, and the faster you will be able to finish those projects. RAM is measured in megabytes.

**Software**: Software is installed on your computer. Often times the words program or application is used to refer to a piece of software.

**Spreadsheet program**: One used to perform calculations or store data. Many people use spreadsheet programs to manage business or household budgets. An example of a spreadsheet program is Microsoft Excel.

**USB flash drive**: A portable solid state storage device that plugs into a computer’s USB port. Also called a pen drive, keychain drive, thumb drive.

**Word processing program**: One used to create written documents such as letters and résumés. An example of a word processing program is Microsoft Word.

---

**Conceptual Outline of Terms:**

I) **Hardware**
   A) **Components**
      • Monitor
      • CPU, Desktop Computer, Tower
      • Mouse
      • Keyboard
      • Speakers
      • Printer
      • Scanner
   B) **CPU**
      • Megahertz (MHz) or Gigahertz (GHz)
   C) **Hard Drive**
      • Gigabytes (GB)
   D) **RAM**
      • Megabytes (MB)
   E) **Modem**
      • Kbps (kilobits per second)

II) **Software**
   A) **Operating System**
      • Microsoft Windows
      • Apple
   B) **Accessories**
      • Calculator
      • Solitaire
   C) **Keyboarding**
      • Ainsworth
      • Mavis Beacon
   D) **Web Browser**
      • Microsoft Internet Explorer
      • Netscape
   E) **Office Suite**
      • Word
      • Excel
      • PowerPoint
      • Access
### Computer Comparison Chart

#### What will you (or your family) be using the computer for?
- [ ] Creating documents for business or personal use
- [ ] Internet and E-mail
- [ ] Graphics (Scanning and Image Correcting)
- [ ] Playing Games and/or Multimedia Use (Video, Audio, etc.)

#### What is your price range?
- [ ] Under $800.00
- [ ] $800.00-$1,200.00
- [ ] $1,200.00-$2,000.00
- [ ] Over $2,000.00

### Comparison Chart

<table>
<thead>
<tr>
<th>Brand</th>
<th>Processor Model and Speed (in MHz or GHz)</th>
<th>RAM (sometimes listed as DRAM or Sync DRAM)</th>
<th>Hard Drive Space</th>
<th>CD-ROM, CD-RW, or DVD drive</th>
<th>Modem and Speed</th>
<th>Storage Devices (Floppy Drive, USB Flash Drive)</th>
<th>Software (Operating System, Applications)</th>
<th>Monitor Included and Size</th>
<th>Additional Peripherals Included (Printer, Scanner, Camera)</th>
<th>Price (List any rebates or contracts for Internet Service)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
<td>□ YES □ NO</td>
</tr>
</tbody>
</table>

|       |                                          |                                          |                  |                            |                |                                 |                           | □ YES □ NO                       | □ YES □ NO                     | □ YES □ NO                           | □ YES □ NO                     |
|       |                                          |                                          |                  |                            |                |                                 |                           | □ YES □ NO                       | □ YES □ NO                     | □ YES □ NO                           | □ YES □ NO                     |
|       |                                          |                                          |                  |                            |                |                                 |                           | □ YES □ NO                       | □ YES □ NO                     | □ YES □ NO                           | □ YES □ NO                     |
|       |                                          |                                          |                  |                            |                |                                 |                           | □ YES □ NO                       | □ YES □ NO                     | □ YES □ NO                           | □ YES □ NO                     |